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Fixing your Format in Word 
NB: This is for older versions of Word, with no ribbons on the screen. 

Why format matters 

Many of us make the screen look how we want the finished product to be. If you 

always use the same pc and printer, that is fine. If you share your document 

electronically, standard formatting is safer because: 

• On another screen or printer, even on the same network, page breaks can 

in appear in unexpected places. 

• PDF or e-book software may not see your formatting the way your eye 

does. Spacing paragraphs by hitting enter several times or using tabs may 

make unexpected spaces or blank pages. 

• People might look to see how you formatted the document. Neatness gives 

a better impression. 

• If you are using an editor, fixing your own formatting saves you money, 

and makes it easier to see the important changes proposed. 

This takes a lot of space to explain, but you will soon get the hang of it. 

Preparation 

Remember to back up your file before making major changes, just in case 

something goes wrong. It is easier to find the file if you need to restore it if you 

use: 

• A separate folder called something like backups or 

archive. 

• A slightly different name, for example by adding 

today's date on the end of the file name. 
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Usually it is best to: 

• Have the whole project in one large document. Things like checking for 

consistency will be easier. If the file is too large to email, you can always 

use a service like Dropbox or https://www.wetransfer.com/. 

• Leave design elements like fancy fonts until after the editing stage. It is 

easier to finalise the structure of headings before deciding on how to 

distinguish them for the reader. This is particularly true for books. 

• Check that you know any specific formatting guidelines you need to follow, 

for example for submitting to an agent or journal. 

• If you don't have guidelines, a good format at this stage is: 

o 12 point Times Roman font for the main text, 

o 1" (2.54 cm) or 1.25" (3.2 cm) margins, 

o text aligned against the left margin, 

o double spacing. 

If you will work with a hard copy, page numbers are useful. Automatic numbers on 

the right of each page are visible, but not distracting. 

If you want to add the book's title, put it in the top right corner. 

Leave page numbers on the contents until after the editing and design stages. Both 

processes will change page numbers. 

Don't make these format changes with track changes turned on. 

How formats work in Word 

Word groups the parts of format in a style. When you make changes like making 

the font larger, Word sets up a new style. This is often why parts you think should 

be the same aren't. The styles seem the same, so it is difficult to see what to do. 

Setting basic styles how you want them can save a lot of 

time. Using them ensures consistent format. 

The picture on the left shows the default styles in a new 

document. Heading 2 and 3 are the first two levels of 

subheading. Headings go into the table of contents when you 

use insert to create it. 

The Formatting tool bar shows the style of a paragraph. Go 

into View, Toolbars and make sure you have ticked it on the list. 

On the left of this bar are three boxes, showing: 

• The style name • The font name • The font size 
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Decide on your styles 

Your headings should have a structure of sections and subsections. Each main 

section (for example a chapter) has a Heading 1. If that section splits into 

subsections, they begin with a Heading 2. These might split again using Heading 3, 

and so on. 

Write down how your structure works, and add how you have shown these levels to 

your notes. You have probably used font size, bold or italics to do this. 

You might need some other styles, such as lists, but you can always set these up 

later. 

The table below takes a simple example of a chapter outline on the left. On the 

right, there is a note of the style used: 

Example text Style 

1: Flower arranging Heading 1 

Whatever you have to say in the introduction… Normal 

Select your flowers Heading 2 

From the garden Heading 3 

You can find all sorts of stuff in your garden… Normal 

From the florist Heading 3 

You might need to buy a few really nice bits and bobs… Normal 

Select your vase Heading 2 

Good grief, I know nothing about this bit… Normal 

Set your styles 

Once you have your heading structure, you need 

to sort out the styles. First, open the Styles and 

Formatting box by going to Format, Styles 

and Formatting. Start with Normal and work 

through the styles you need. When you hover 

over a style name on the list, you get access to a 

drop down menu. Select Modify to get the box 

shown on the left. 

Here you will see boxes or icons to select: 

• Font name and size: usually 12 point 
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Times Roman. 

• Alignment: usually left or justified. 

The changes you make will show in the sample window. 

The Modify Style box can set the style for the following paragraph automatically. 

For the body text, you could set the normal style so the next paragraph is normal 

as well. Headings might have a subheading or text next, so ignore the automated 

option here. 

You can set line spacing, paragraph spacing, and indentation here, but I find is 

easier to use the Paragraph format box, see below. 

Think carefully about whether to tick the box to update the style automatically. This 

updates the style when you make a change directly to a paragraph in that style. 

Sometimes you will change your styles without noticing you've done it, changing 

any other paragraph using that style. 

There is a box to tick if you want the settings available for templates. 

Before you leave this box, click on the 

Format box at the bottom and select 

Paragraph. 

On the Indents and Spacing tab, set: 

• Text alignment if you haven't 

already done so. 

• Spacing has two elements: 

o Line spacing: usually 

double. 

o Before/after, setting the 

spaces round paragraphs. 

NEVER use Auto here, as 

it is unpredictable. A 

useful standard is 0 point before, 6 point after. 

• Paragraph indentation: 

o Set special to First Line. 

o Note: Kindle automatically indents paragraphs if no indentation is 

set. If you don't want indented paragraphs in your Kindle book, 

set a small indent of 0.01" (0.02cm). Type the number in as it is 

so small. 

o In fiction, it is usual to indent each paragraph, but the first 

paragraph of each chapter is not indented. Once you have set 

your normal style, set a first paragraph style. Click on New 
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Style, which is towards the 

top of the Styles and 

Formatting box. Use your 

normal style as a base for any 

modifications to avoid re-

inventing the wheel. A logical 

name helps you to find it 

again. 

For an eBook, it is very important to use 

these settings to organise your layout 

rather than using tabs and inserting extra lines. 

They cause unexpected gaps and blank pages 

to appear in eBooks. 

For headings, there are 2 other boxes to consider before you click on OK. 

Go onto the Line and Page Breaks tab of the Paragraph window and look at the 

right hand side of the top section for the self-explanatory: 

• Keep with next, which you should tick for all heading styles. 

• Page break before, which is useful for headings you want on a new 

page. 

When you have set up all the styles you think you need, you are ready to carry on 

to the next stage. Remember: 

• You can always set up more styles later if you need them. 

• If you modify the basic styles it can be easier to keep track of them. 

• Use a style you have already sorted out as a base to save work. 

See the formatting code 

To see the document as Word sees it, find the Show/Hide button, with the symbol 

¶ (a pilcrow) on the Standard tool bar. This toggle button lets you see things that 

don't appear on the printed page, such as: 

o spaces (dots) 

o tabs (arrows) 

o manual line breaks (bent arrows) 

o hard returns (pilcrows ¶) 

o page breaks (a row of tiny dots) 

o non-breaking spaces (circles) 

The ¶ mark tells Word how to display the characters shown before it. Delete or fail 

to copy that ¶ and you lose the formatting of the section. 
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The plan 

You are now ready to start sorting out your document. The stages are: 

• Convert automatic paragraph numbers to typed numbers. 

• Apply the standard styles you have set up. 

• Put page breaks where needed. 

• Take out extra characters. 

Convert automatic paragraph numbers 

There are 2 ways of dealing with these sections, but you should use the second if 

you have footnotes. 

1. If you have no automatic footnotes: 

• Highlight the whole automatically numbered section. Click Copy, and 

then click on the paragraph numbering icon to remove the 

numbering. Next put the numbers back in by going to the Edit menu 

and clicking on: 

o Paste Special 

o Unformatted text 

• The list is still numbered, if you hit return half way down: 

o The new line doesn't get a number. 

o The subsequent numbers don't change. 

• Change the tab after the number to a space by: 

Find: ^t (shift and 6, followed by lower case t) 

Replace: Hit the space bar once 

Click Replace all. 

2. If you have automatic footnotes, you'll want to keep them, so: 

• Highlight the section of text. 

• Open a Microsoft Visual Basic screen (Alt and F11 together). 

• Under the View tab in this window (top), choose Immediate Window 

to open a little window at the bottom of the screen. 

• Type the following (with the capital letters) or paste it in: 

Selection.Range.ListFormat.ConvertNumbersToText 

• Hit Enter and close the Visual Basic screen (the x top right). 
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• Deal with the tabs as explained under the previous option. 

Mark your headings 

Some people start by setting the whole document to Normal style. That assumes 

you will be able to find all your headings and subheadings easily afterwards. With it 

all in Normal style, subheadings can be hard to spot. 

Start by formatting all the Heading 1s. 

If you don't want to use Find and Replace, go to each heading, highlight it, and 

choose Heading 1 on the style name list. 

To use Find and Replace: 

• On the Find tab, go to the Format drop down menu. Here you can 

specify the format you used for your chapter heading, for example 

Font: Bold. You will see your selection under the Find box. If you 

make a mistake, click on No formatting and start again. Be careful if 

you have used different font sizes, for example in different levels of 

headings. Make sure the Find box is empty. 

• On the replace tab, go to format, style, Heading 1. 

• Click replace all. 

Repeat for each level of headings. Remember to click on No formatting when you 

have finished. 

Dealing with the rest of the text 

You might be lucky and find that you have already finished. Find what styles you 

are using by going to the Format menu, click Styles and Formatting. This opens 

a box on the right of the screen. At the bottom there is a box called Show. I find 

the most useful options are All styles and Formatting in use. If you only look at 

the formats in use, and they are all ones you have adjusted, you have finished 

applying styles. 

You can work through, highlighting chunks of text and converting them to the right 

style. A chunk might be the whole area between headings for conversion to 

Normal. You might need to stop a chunk when you get to the beginning of 

something like a list. Select the style for the chunk (eg Normal) from the list of 

styles on the formatting toolbar. 

You can convert similar items at the same time. Select Formatting in use on the 

Styles and Formatting box. Be careful to click on the drop down menu next to 

the style, not the style itself. Click on Select all x instances. If you now click on 

the appropriate style, it will convert all the places selected. 
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Remember if you don't want the first paragraph of each chapter to be indented, you 

have to apply an adapted style. Get to these quickly by using Find to get to style 

Heading 1. 

Other page breaks 

Remember that an eBook producer can't control the size of a page. That depends 

on the settings the reader uses for the font and the size of their screen. If there are 

any other places you need to have a new page, the easiest way to insert a page 

break is Insert, Break, select Page break and OK. 

Take out unnecessary formatting and extra characters 

Open up Find and Replace and work through this list. Repeat each search until 

there are no more replacements. 

Problem Find Replace 

Remove double spaces 

between sentences 

two spaces (tap the space 

bar twice) 
one space 

Remove tabs (small 
arrows) 

^t (shift and 6, followed 
by lower case t) 

Leave it empty 

Remove extra spaces at 
the beginning of lines 

^p followed by a space 
(space bar) 

^p 

Remove spaces at the end 

of lines 
space followed by ^p ^p 

Remove extra lines ^p^p ^p 

Remove soft line breaks ^l (that's L for line) leave empty 

Margins 

I suspect most Word users know this, but just 

in case… 

To set the margins, go to File, Page Setup, 

and enter your settings. Make sure you select 

Apply to: Whole document. 

For a summary of these notes, see The Proof 

Angel Quick Guide to Fixing Your 

Format in Word. 


